


INTRODUCTION TO Ms-EXCEL

Microsoft Excel is a list-based application. That is, it is used to create and manage lists of information. To effectively handle list-related assignments, this environment provides many more features than simply deal with lists. 

It is used to make spreadsheets. 
A spreadsheet is the computer equivalent of a paper ledger sheet. It consists of a grid made from columns and rows. It is an environment that can make number manipulation easy and somewhat painless. 
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Spreadsheets can be very valuable tools in business. They are often used to play out a series of what-if scenarios! (much like our car purchase here.) 

So let's get started digging into what makes a spreadsheet work. Spreadsheets are made up of 

· columns 

· rows 

· and their intersections are called cells

In each cell there may be the following types of data 

· text (labels) 

· number data (constants) 

· formulas (mathematical equations that do all the work)

Starting Ms-Excel
To start Microsoft Excel click
Start -> (All) Programs -> Microsoft Excel
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After clicking on Microsoft word the window opened will look like:
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Microsoft Excel is a classic computer application and easily recognizable if you have spent some time with other Microsoft Office applications. On top of the application, it displays a horizontal object called the title bar.
On the left side of the title bar, there is a small picture called the application icon or the system icon. This icon allows you to minimize, maximize, restore, resize, move, close Microsoft Excel. To perform any of these actions, you would click the icon and this would display a menu:
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 On the right side of the application icon, the name of the program, in this case, Microsoft Excel, displays. The application's name is followed by the file name; in this case Book1.
 

Microsoft Excel identifies each one of its documents with a name that starts with Book. Microsoft Excel is a Multiple Document Interface (MDI), which means you can open more that one document inside the application. Therefore, if you create or initialize more than one document in Microsoft Excel, subsequent documents would be called Book2, Book3, BookX.

Working in  Ms-Excel
WORKING ON SPREADSHEETS USING Ms-Excel
1.

DEFINING ROWS AND COLUMNS

In a spreadsheet the COLUMN is defined as the vertical space that is going up and down the window. Letters are used to designate each COLUMN'S location. 

[image: image4.png]Workbook1
A [ B [ © T »

ENEEREN

[ i, Sheet1 (Shestz 7 Sheef [ 1]





In the above diagram the COLUMN labeled C is highlighted.

In a spreadsheet the ROW is defined as the horizontal space that is going across the window. Numbers are used to designate each ROW'S location. 
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In the above diagram the ROW labeled 4 is highlighted.

In a spreadsheet the CELL is defined as the space where a specified row and column intersect. Each CELL is assigned a name according to its COLUMN letter and ROW number. 
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In the above diagram the CELL labeled B6 is highlighted. When referencing a cell, you should put the column first and the row second

Formulas are entries that have an equation that calculates the value to display. We DO NOT type in the numbers we are looking for; we type in the equation. This equation will be updated upon the change or entry of any data that is referenced in the equation. 
2.

SELECTING OF CELLS

Selecting cells in an equation is a very important concept of a spreadsheet. We need to know how to reference the data in other parts of the spreadsheet. When entering your selection you may use the keyboard or the mouse. 

We can select several cells together if we can specify a starting cell and a stopping cell. This will select ALL the cells within this specified BLOCK of cells. 

If the cells that we want to work with are not together (non-contiguous cells) we can use the comma to separate the cells or by holding down the control-key (command key on a MAC) and selecting cells or blocks of cells the comma will be inserted automatically to separate these chunks of data. 



For the following examples lets consider the table below: 

	· A1 (column A, row 1) = 5 

· A2 (column A, row 2) = 7 

· A3 (column A, row 3) = 8 

· B1 (column B, row 1) = 3 

· B2 (column B, row 2) = 4 

· B3 (column B, row 3) = 6 
	A

B

1

5

3

2

7

4

3

8

6




This is just a discussion of selection methods. If we wanted to add the cells in the (To Select) you would type in

=sum(Type In) 
or
=sum(Click On) 
	To Select
	Type In
	Click On

	A1
	A1
	· click on A1

	A1, A2, A3
	A1:A3
	· click on A1 

· with button down 

· drag to A3

	A1, B1
	A1:B1
	· click on A1 

· with button down 

· drag to B1

	A1, B3
	A1, B3
	· click on A1 

· type in comma 
(or hold down the control key on a PC)
(or hold down the command key on a MAC) 

· click on B3

	A1, A2, B1, B2
	A1:B2
	· click on A1 

· with button down 

· drag to B2


3.

VARIOUS FUNCTIONS

Spreadsheets have many Math functions built into them. Of the most basic operations are the standard multiply, divide, add and subtract. These operations follow the order of operations (just like algebra). Let's look at some examples. For these following examples lets consider the following data: 

	· A1 (column A, row 1) = 5 

· A2 (column A, row 2) = 7 

· A3 (column A, row 3) = 8 

· B1 (column B, row 1) = 3 

· B2 (column B, row 2) = 4 

· B3 (column B, row 3) = 6 
	A

B

1

5

3

2

7

4

3

8

6




	Operation
	Symbol
	Constant
Data
	Referenced
Data
	Answer

	Multiplication
	*
	= 5 * 6
	= A1 * B3
	30

	Division
	/
	= 8 / 4
	= A3 / B2
	2

	Addition
	+
	= 4 + 7
	= B2 + A2
	11

	Subtraction
	-
	= 8 - 3
	= A3 - B1
	5


Probably the most popular function in any spreadsheet is the SUM function. The Sum function takes all of the values in each of the specified cells and totals their values. The syntax is: 

· =SUM(first value, second value, etc) 

In the first and second spots you can enter any of the following (constant, cell, range of cells). 

· Blank cells will return a value of zero to be added to the total. 

· Text cells can not be added to a number and will produce an error. 



	Lets use the table here for the discussion that follows: 

We will look at several different specific examples that show how the typical function can be used! Notice that in A4 there is a TEXT entry. This has NO numeric value and can not be included in a total.
	A

1

25

2

50

3

75

4

test

5






	Example
	Cells to ADD
	Answer

	=sum (A1:A3)
	A1, A2, A3 
	150

	=sum (A1:A3, 100)
	A1, A2, A3 and 100
	250

	=sum (A1+A4)
	A1, A4
	#VALUE!

	=sum (A1:A2, A5)
	A1, A2, A5
	75


There are many functions built into many spreadsheets. One of the first ones that we are going to discuss is the Average function. The average function finds the average of the specified data. (Simplifies adding all of the indicated cells together and dividing by the total number of cells.) The syntax is as follows. 

· =Average (first value, second value, etc.)
Text fields and blank entries are not included in the calculations of the Average Function. 



	Lets use the table here for the discussion that follows: 
We will look at several different specific examples that show how the average function can be used!
	A

1

25

2

50

3

75

4

100

5



	Example
	Cells to average
	Answer

	=average (A1:A4)
	A1, A2, A3, A4
	62.5

	=average (A1:A4, 300)
	A1, A2, A3, A4 and 300
	110

	=average (A1:A5)
	A1, A2, A3, A4, A5
	62.5

	=average (A1:A2, A4)
	A1, A2, A4
	58.33


The next function is Max (which stand for Maximum). This will return the largest (max) value in the selected range of cells. 

· Blank entries are not included in the calculations of the Max Function. 

· Text entries are not included in the calculations of the Max Function. 



	Lets use the table here for the discussion that follows. 
We will look at several different specific examples that show how the Max functions can be used!
	A

1

10

2

20

3

30

4

test

5






	Example of Max
	Cells to look at
	Ans. Max

	=max (A1:A4)
	A1, A2, A3, A4
	30

	=max (A1:A4, 100)
	A1, A2, A3, A4 and 100
	100

	=max (A1, A3)
	A1, A3
	30

	=max (A1, A5)
	A1, A5
	10


The next function is Min (which stands for minimum). This will return the smallest (Min) value in the selected range of cells. 

· Blank entries are not included in the calculations of the Min Function. 

· Text entries are not included in the calculations of the Min Function. 



	Lets use the table here for the discussion that follows. 
We will look at several different specific examples that show how the min functions can be used!
	A

1

10

2

20

3

30

4

test

5






	Example of min
	Cells to look at
	Ans. min

	=min (A1:A4)
	A1, A2, A3, A4
	10

	=min (A2:A3, 100)
	A2, A3 and 100
	20

	=min (A1, A3)
	A1, A3
	10

	=min (A1, A5)
	A1, A5 (displays the smallest number)
	10




The next function is Count. This will return the number of entries (actually counts each cell that contains number data) in the selected range of cells. 

· Blank entries are not counted. 

· Text entries are NOT counted. 



	Lets use the table here for the discussion that follows. 
We will look at several different specific examples that show how the Count functions can be used!
	A

1

10

2

20

3

30

4

test

5






	Example of Count
	Cells to look at
	Answer

	=Count (A1:A3)
	A1, A2, A3
	3

	=Count (A1:A3, 100)
	A1, A2, A3 and 100
	4

	=Count (A1, A3)
	A1, A3
	2

	=Count (A1, A4)
	A1, A4 
	1

	=Count (A1, A5)
	A1, A5
	1




The next function is CountA. This will return the number of entries (actually counts each cell that contains number data OR text data) in the selected range of cells. 

· Blank entries are not Counted. 

· Text entries ARE Counted. 



	Lets use the table here for the discussion that follows. 
We will look at several different specific examples that show how the CountA functions can be used!
	A

1

10

2

20

3

30

4

test

5




	Example of CountA
	Cells to look at
	Answer

	=CountA (A1:A3)
	A1, A2, A3
	3

	=CountA (A1:A3, 100)
	A1, A2, A3 and 100
	4

	=CountA (A1, A3)
	A1, A3
	2

	=CountA (A1, A4)
	A1, A4 
	2

	=CountA (A1, A5)
	A1, A5
	1


The next function is IF. The IF function will check the logical condition of a statement and return one value if true and a different value if false. The syntax is 

· =IF (condition, value-if-true, value-if-false)

· value returned may be either a number or text 

· if value returned is text, it must be in quotes



	Lets use the table here for the discussion that follows. We will look at several different specific examples that show how the IF functions can be used!
	A

B

1

Price

Over a dollar?

2

$.95

No

3

$1.37

Yes

4

comparing #

returning #

5

14000

0.08

</TD< tr> 

6

8453

0.05






	Example of IF
typed into column B
	Compares
	Answer

	=IF (A2>1,"Yes","No")
	is ( .95 > 1)
	No

	=IF (A3>1, "Yes", "No")
	is (1.37 > 1)
	Yes

	=IF (A5>10000, .08, .05)
	is (14000 > 10000)
	.08

	=IF (A6>10000, .08, .05)
	is (8453 > 10000)
	.05




Excel has most of the math and trignometric functions built into it. If you need to use the SIN, COS, TAN functions, they can be typed into any cell. If you wanted to find: 

	angle
	sin
	cos
	tan

	REF
	=sin(REF)
	=cos(REF)
	=tan(REF)

	0
	0.00
	1.00
	0.00

	30
	0.50
	0.87
	0.58

	45
	0.71
	0.71
	1.00

	90
	1.00
	0.00
	  

	180
	0.00
	-1.00
	0.00


format for degrees formula = sin (angle * pi()/180) the argument angle is in degrees
format for radians formula = sin (angle) the argument angle is in radians

To calculate trig functions in degrees you must convert them - otherwise excel will calculate them in radians. 

You can type in either an actual number for the REF or you can also type in a reference from the excel spreadsheet (like A2). 

In Excel there is a help tool for functions called the Function Wizard. 

There are two ways to get the function wizard. If you look at the Standard Toolbar, the function wizard icon looks like the icon on the right. 

The other way to get to the function wizard is to go to the Menu INSERT -- down to FUNCTION. 
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Either way you get there, at this point Excel will list all of the functions available. Upon choosing the function
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 Excel will prompt you for the information it needs to complete the function. Mini descriptions are available for each of the cells. It is often necessary for you to understand the functions in order to be able to figure out these descriptions. 

IF YOU WANT TO REPEAT THE SAME FORMULA

Sometimes when we enter a formula, we need to repeat the same formula for many different cells. In the spreadsheet we can use the copy and paste command. The cell locations in the formula are pasted relative to the position we Copy them from. 

		A

	B

	C


	1

	5

	3

	=A1+B1


	2

	8

	2

	=A2+B2


	3

	4

	6

	=A3+B3


	4

	3

	8

	=? + ?



	
	Cells information is copied from its relative position. In other words in the original cell (C1) the equation was (A1+B1). When we paste the function it will look to the two cells to the left. So the equation pasted into (C2) would be (A2+B2). And the equation pasted into (C3) would be (A3+B3). 



If you have a lot of duplicate formulas you can also perform what is referred to as a FILL DOWN. 

Often we have several cells that need the same formula (in relationship) to the location it is to be typed into. There is a short cut that is called Fill Down. There are a number of ways to perform this operation. One of the ways is to 

1. select the cell that has the original formula 

2. hold the shift key down and click on the last cell (in the series that needs the formula) 

3. under the edit menu go down to fill and over to down 

		A

	B

	C


	1

	5

	3

	=A1+B1


	2

	8

	2

	fill down


	3

	4

	6

	fill down


	4

	3

	8

	fill down



	
	Cells information is copied from its relative position. In other words in the original cell (C1) the equation was (A1+B1). When we paste the function it will look to the two cells to the left. So the equation pasted into (C2) would be (A2+B2). And the equation pasted into (C3) would be (A3+B3). And the equation pasted into (C4) would be(A4+B4). 


Formatting of the cells in Ms-Excel
The cells can be formatted like: bold face, italics, underline, change the color, align (left, right, center), font size, font, etc. 

This can be done in the following way:

Select the cell (or group of cells) that we wish to change the formatting and then go from the FORMAT menu -- down to CELLS -- click on FONT. Here is a picture of what you will see there. Notice that you can choose to change the alignment as well as several other options. 
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We often need to format the numbers to display the appropriate number of decimals, dollar signs, percentage, red (for negative dollars), etc. It is best to keep numbers describing similar items as uniform as possible.
If we have the number 3.53262624672423, we would probably have to make the column wider and at the least bore most people. We need to set the number of decimal places to what is important. If this was a dollar figure that had calculated tax it should be $3.53. 

Here is a screen displaying what you would see if you select a cell (or group of cells) and from the FORMAT menu -- go down to format -- click on number. 
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Sometimes we (all) make mistakes or things change. If you have a spreadsheet designed and you forgot to include some important information, you can insert a column into an existing spreadsheet. What you must do is click on the column label (letter) and choose in Columns from the Insert menu. This will insert a column immediately left of the selected column. 
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As you can see from this example there was a blank column inserted into the spreadsheet. You might wonder if this will affect your referenced formulas. Yes, the Referenced cells are changed to their new locations. For example:
Cell C4 was =C3+B4
and now is =D3+B4 Likewise, we can also insert rows. With the row label (number) selected you must choose the Row from the Insert menu. Again this will insert a row before the row you have selected. 
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The formulas will be updated to their corresponding locations.
C3 was = C2+B3
OW C4=C2+B4 
4.

INSERTING GRAPHS AND PIE CHARTS IN Ms-Excel
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Numbers can usually be represented quicker and to a larger audience in a picture format. Excel has a chart program built into its main program. The Chart Wizard will step you through questions that will (basically) draw the chart from the data that you have selected. There are many types of charts. The two most widely used are the bar chart and the pie chart. 

The BAR Chart is usually used to display a change (growth or decline) over a time period. You can quickly compare the numbers of two different bar charts to each other.

The PIE Chart is usually used to look at what makes up a whole something. If you had a pie chart of where you spent your money you could look at the percentages of dollars spent on food (or any other category).
The chart can be used in the following way:

1. First enter the data which you have to show in the chart. 
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2. Click on insert and select chart.
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3. After selecting chart following wizard will be opened.

[image: image18.png]icrosoft Excel - Book1

Ele Edt Vew Iset Fomat ook Data Window Help Type a question for help '+

DEZHAE SRY 1 BE-I o-o @z -4 @§ow -0, w cw0 By

it shepe | ©F 0 5 | Lavoute | £ | changeto+

H5 > A
A B [ D E F G H I J K L M N o] P Q 3
1
2
3
4 40 E 70 100 30 Chart Wizard - Step 1 of 4 - Chart Type
5 201 90, 23, 340 B0
o Standard Types | Custom Types
7 Chart type: Chart sub-type:
2 m
£l & o
i I tine
@ re
12 2 %¥ (Scattery
13 Ihap Area
14 @ Doughnut
15 Iy Radar —
18 @ surface
7 e
& i stock
20 lustered Column. Compares values across.
5 gt
2
23
24
25
26 < Back
pri
28
29
30
31
32
33
34
35
36
37 —
38
s W\ sheett {sheeta { shests 14l |

= EsEf %P,

Ready [





Select the choice of chart you want and click on next. After clicking on next the data which you have entered gets selected and then you can complete the wizard according to your choice. 
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4. In the last click on finish and you will get the data represented in the following way as an output.
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Saving work in Ms-Excel
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A Microsoft Excel file gets saved like any Windows application file. Two issues are important. Whenever you decide to save a file for the first time, you need to provide a file name and a location. The file name helps the computer identify that particular file and registers it.

A file name can consist of up to 255 characters; you can include spaces and dashes in a name. Although there are many characters you can use in a name (such as exclamation points, etc), try to avoid fancy names. Give your file a name that is easily recognizable, a little explicit. For example such names as Time Sheets, Employee's Time Sheets, GlobalEX First Invoice are explicit enough. Like any file of the Microsoft Windows operating systems, a Microsoft Excel file has an extension, which is .xls but you don't have to type it in the name.

The second important piece of information you should pay attention to when saving your file is the location. The location is the drive and/or the folder where the file will be saved. By default, Microsoft Excel saves its files in the My Documents folder. You can change that very easily in the Save As dialog box. Just click the arrow of the Save In combo box and select the folder you want.

Microsoft Excel allows you to save its files in a type of your choice. To save a file in another format than the default Microsoft Excel file, from the Save As dialog box, click the arrow of the Save As Type combo box and select a format of your choice.
There are other things you can do in the Save As dialog box, we will address them as we move along.

To save a file for the first time, you can click File on the main menu, then click Save (if the file has not been saved before, the File -> Save menu will call the Save As dialog box). You can also click the Save button on the Standard toolbar. You can as well press Ctrl + S. Other alternatives include pressing F12, Alt + F2, or Shift + F12.
 



VIVA QUESTIONS

1. What is Ms-Excel? It is an application or software?

2. List few features of Ms-Excel.

3. What do you understand by the term spreadsheet?
4. How can you represent rows and columns in Ms-Excel?
5. What is the advantage of using spreadsheets?
6. The intersection of row and column in Ms-Excel is called what?
7. Why do we use labels in Ms-Excel?
8. How can we use pie-charts and graphs in Ms-Excel?



EXPERIMENTS TO PERFORM

1. Create a Macro and use it in an application.
2. Enter the name and marks of 10 students and perform various mathematical functions on it.             
3. Enter first quarter performance of five companies and create a pie chart showing there share holders in the markets.                                                                                                                            
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